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SITE - SITE DATA MANAGEMENT

1.

INTRODUCTION

The Site module is used for the interactive treatment of geographical information relative to
sites. It allows the user to display borings and their geotechnical properties in a spatial system
in 2D and 3D in addition to a cartographic map.
Site uses a Graphical User Interface (i.e. with windowing) that is compatible with Microsoft
Windows 7, 8 and 10.
Site uses the Geo, X3D and SM2 libraries created by Sobek Technologies Inc. for data editing,
the definition of the presentation style, and viewing and editing graphic results. Please refer to
the Frm, X3D and SM2 guides for all details.

2.

LAUNCHING THE SITE MODULE

To open Site, double-click on the icon shown here.
The connection to the database can be done directly when calling Site by entering the following
string as target. The string will be:
C:\Geotec80\Bin\Site.exe username/password@odbc:connection_alias
See paragraph 2 of chapter 2 of the X3D guide for all the details about the connection to a
database. Once the connection to a database is done, the user can execute a data query to
produce a plan or 3D view.
When Site is first launched, the following files are loaded from C:\Geotec80\Style:
•

the markers file geotec8.mrk;

•

the patterns file geotec8.ptn;

•

the style file site_landscape.sty which is a classic presentation model showing a plan
view.

The user can begin working with this initial presentation, or open another style file included with
the software. He can modify the style file and save it in a new presentation. In subsequent
loadings, Site opens the style, markers and patterns files that were in use when Site was
closed.

3.

FILE, EDIT AND INSERT MENUS

None of the options of the File, Edit and Insert menus is specific to Site. The detailed
description of each option of these menus is done in chapters 2, 3 and 4 of the X3D library
guide.
Introduction
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4.

VIEW MENU

The 2D View and 3D View options of the View menu and this button
the view of the PLAN_VIEW graph.

are used to change

In the axes editing window, it is possible to change from 2D to 3D view and vice-versa for
PLAN_VIEW. For the sub-graphs, the box cannot be checked.
The OpenGL mode can be used with Site. OpenGL is used to view solids and surfaces with
hidden lines and faces and shadows in 3D. See paragraph 5.1.4 for more details. The XVT
mode is the standard display mode.

5.

TOOLS MENU

The options of the Tools menu are used to define the utilisation parameters of Site and to edit
the graphic components produced by Site: the characteristics of the graphic page, the graph,
sub-graphs and their curves, the legends, the axes, the markers and patterns used. All these
options are described in details in chapter 6 of the X3D library guide.
Options is specific to Site. It is presented in paragraph 5.3. The definitions of the graphs and
curves are presented succinctly in the following paragraphs.
The SM2 Mode option is also specific to Site. It opens the SM2 library for the site mapping and
modeling. This button is equivalent. See the SM2 guide for all the details.

5.1.

Definition of the graphs

The list of graphs is established and updated in the graph editing window opened by selecting
the Graphs… option of the Tools menu or by clicking the button shown on the left. More details
about the graph editing are available in paragraph 4 of chapter 6 of the X3D guide. Figure 1
shows the graph editing window in Site.
The table in this window contains all the graphs defined in the style file used. Each graph is
identified by a unique number in the # column. The first graph is always Page with # 0. This
graph represents the graphic page and cannot be deleted.
Among the graphs, there is the primary graph PLAN_VIEW whose #P cell is 0 and the subgraphs whose #P cell is a negative value.
5.1.1.

The primary graph

The primary graph is the PLAN_VIEW graph (#1). This graph cannot be deleted. This graph
can also be set in 3D. A topographic background can be displayed in the plan view (in 2D and
3D).
The plan view shows the location of the borings with markers. Specific information from the
BORING table can also be displayed under each boring point displayed. In addition, the axes
can be displayed, markers showing their turning points and their ends. Paragraph 11.1 presents
this graph.
2018-10-01
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When the graph is in 3D, the tridimensional view shows as columns the borings and their
properties defined as sub-graphs. Paragraph 11.2 presents this graph.
For the primary graph, the Left, Width, Right, Bottom, Height and Top fields define its
position and dimensions; the user can modify these values.

Figure 1 - Graph editing window
5.1.2.

The sub-graphs

Among the sub-graphs (negative value in their #P cell), HEADER is different from the other
sub-graphs; it defines the boxes that include the identifiers of the borings in the tridimensional
view.
The other sub-graphs define the presence and the size of the property columns of the borings
represented in the 3D view. The content of these graphs is defined in the legend and curves
editing window. See paragraph 5.2 for details.
For the HEADER sub-graph, the Left, Width, Right, Bottom, Height and Top fields reflect the
position and size of the eventual identification boxes of the borings in the 3D view. See
paragraph 12.4 for the details.

Tools menu
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For the other sub-graphs, the Left, Width and Right fields define the layout of the property
columns with respect to the axis of the boring and the width of these columns. The Bottom,
Height and Top fields are not used.
5.1.3.

Addition and substitution of graphs

The user can add a graph or replace a graph with another. Site automatically manages the
numbering of the graphs. The user selects the graph name in the scrolling list displayed by
clicking on the button to the right of the Name cell.
The scrolling list of graphs presented in figure 2 shows the PLAN_VIEW and HEADER graphs,
which are presented at paragraphs 11.1 and 12.4 respectively. These graphs are followed by
the list of tables and views in the database that contain a depth field and / or a sample number.

Figure 2 - Scrolling list of graphs
After selecting in the scrolling list a table or view name, the user will be able to create a subgraph. Paragraph 12.1 presents this creation in details. Some sub-graphs have a predefined
display in Site. Details are presented in paragraph 12.
After creating a new graph or replacing a graph with another, the user must execute a new
query for the data associated to the new graph to be read in the database and the graph filled
with information.
The user can also define a graph whose name is not in the scrolling list to add objects in the
space occupied by this graph. These objects are usually general information such as the site
number, the company logo, etc. Chapter 4 of the X3D library guide describes object editing.
5.1.4.

OpenGL

The last column (OGL) of the graph editing window is used only for the OpenGL mode in 3D.
The user enters the value of the radius corresponding to the maximum scale for the numerical
values. For example, if an OGL of 5 is entered for the SAMPLE graph displaying the RQD of
the samples, an RQD of 100% will be 5m in OpenGL, of 20% will be 1m, etc.
In OpenGL mode, the user can then save his data file in an .iges format to export in CATIA.

5.2.

Definition of the curves

The list of curves of a graph is established and updated in the legend and curves editing
window opened by selecting the Legend option of the Tools menu or by clicking on the button
2018-10-01
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shown here. More details about the legend and curves editing are available in paragraph 5 of
chapter 6 of the X3D guide. Figure 3 shows the curves editing window for a STRATIGRAPHY
sub-graph. Paragraph 12.1 explains the creation of sub-graphs and the definition of their
curves.

Figure 3 - Curves editing window
The PLAN_VIEW primary graph has predefined curves. They are described in paragraphs 11.1
and 11.2. The other curves are defined by the user and are used to display information from
various fields of the BORING table under each boring point.
If the selected graph has predefined curves, they will be displayed in the table at the bottom of
the window with a number greater or equal to 100. If the user deletes the predefined curves,
they will be regenerated when he opens the window again.
Except for the PIEZOMETER sub-graph which only contains predefined curves (see paragraph
12.7), the user can define one or several curves per sub-graph. For this, the user inserts a
curve whose number is automatically generated and chooses the name of the curve from the
scrolling list associated to the Name field. The scrolling list is the list of the fields from the table
to which the sub-graph is associated.
If the user replaced a sub-graph with another one, the curves are not automatically modified.
The user will delete the curves from the previous sub-graph or choose the new curves from the
scrolling list of the Name column.

Tools menu
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5.3.

Options

The Options item of the Tools menu or the button shown here opens the window of options for
data display, shown in figure 4, where the user can define the display parameters of the
borings, axes, limits, etc. in the plan view (and 3D view).
5.3.1.

Maps and domains display

•

Upon navigating, the user can choose to display only the current site or all the sites at
once. When all the sites of a query are displayed, they are shown according to the option
selected for the calculated domain (see below). By navigating among the records, the
current site is shown in red.

•

The user can display the site map and/or the region map in the plan view or 3D view by
checking the corresponding box. The site map is entered in the FILE_NAME field of the
SITE table, must be located in the directory of the input files and of a .sit extension. The
region map is entered in the FILE_NAME field of the REGION table, for the region
associated to the site and must also be in the directory of the input files or have its
complete path and be of .sit extension.

•

A scrolling list Is used to choose the basis of the calculated domain:
o The SITE table - based on the EASTING, NORTHING, WIDTH, HEIGHT and ANGLE
fields of the SITE table.
o The site map - based on the site map in a .sit file (the site map must be displayed).
o The REGION table - based on the EASTING_MIN, EASTING_MAX, NORTHING_MIN
and NORTHING_MAX of the REGION table for the region associated to the site.
o The region map - based on the region map in a .sit file for the region associated to the
site (the region map must be displayed).
o Borings location - the area including all the borings retrieved. This mode is particularly
useful for the early detection of errors in the coordinates.
o Axes location - the area including all the turning points of the axes and the associated
profiles retrieved (for the 3D view).
o Axes and borings location - the area including all the borings and axes retrieved.
o Limit defined domain - the area including the polygonal limit retrieved, the one whose
name is the same as the site retrieved, or the one that has the site retrieved as
reference.
o All available data - the area including all borings, axes and domains associated to the
sites and regions and to their respective topographic maps.

•

Check the box Display domains to display the outlines of the domains specified below.

•

Check the box Detect domains to display information about the domains in a tooltip when
the user moves the mouse on a domain outline. The domains must be displayed for this
option to be available.

•

With the option Display file with extension, the user can display an additional topographic
file, on top of the site map (.sit). The file displayed will be the one whose name is indicated

2018-10-01
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in the FILE_NAME field of the SITE table, located in the input files directory, and with the
extension selected in the scrolling list.

Figure 4 - Data display options
•

The next five buttons open the drawing attributes configuration window, and correspond to
the curves numbered #130 to #134 in the legend and curves editing window for the
PLAN_VIEW graph (see figure 11). It is possible to define the attributes from both
locations. See paragraph 11.1 for all the details.
o The button next to the label Calculated domain corresponds to the dom_calculated
curve (#134), which delimits the resulting domain, calculated according to the option
selected in the drop-down list.
o The buttons next to the labels Site domain from database and Region domain from
database correspond to the dom_site_db (#130) and dom_region_db (#131) curves,
which delimit the domain of the site and of the region, as defined in the database.
o The buttons next to the labels Site map domain and Region map domain correspond
to the dom_site_map (#132) and dom_region_map (#133) curves, which delimit the
site map and region map in the .sit files.

5.3.2.
•

Geotechnical data display

The buttons in this section open the drawing attributes configuration window, and
correspond to the curves numbered 100 to 102, 110 and 120 in the legend and curves
editing window for the PLAN_VIEW graph (see figure 11). It is possible to define the
attributes from both locations. See paragraph 11.1 for all the details.
o The Axis points button corresponds to the Axis_Points curve (#100) and is used to
define the line passing through the turning points of the axes and the markers at these
points.
o The Axis curve button corresponds to the Axis_Curve curve (#101) and is used to
define the curvature of the axes, their identification and their symbol for their end points.

Tools menu
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o The Axis profile button corresponds to the Axis_Profile curve (#102) and is used to
define the position of the geophones and the profiles obtained.
o The Boring button corresponds to the Boring curve (#110) and is used to define the
identification of the borings in the plan view, their symbol and their projection.
o The Sampling button is not used.
o The Limit button corresponds to the Limit curve (#120) and is used to define the
rectangular or polygonal limits.
If the retrieval is done via the Axis entry form (similarly to the usage in Pro):
•

Check the box “Display only borings close to current axis” to retrieve a rectangular limit
around the axis, of a distance specified in the following field (m). If the option ‘display all
sites’ is selected, Site retrieves only the borings around the current axis, otherwise a very
large number of data could be returned. In this case, the box cannot be unchecked.

•

Check the box “Within a distance to the axis of” to display only the borings located at a
distance to the axis smaller or equal to the distance (m) indicated in the related field.

•

Check the box Display in AutoCAD mode to set the texts in geographic coordinates
instead of millimeters, for a better compatibility of the .dxf files produced for AutoCAD. This
box is not active if the Google map is displayed.

•

The Elevation = 0 checkbox is used solely for AutoCAD mode. The distances are then
calculated horizontally instead of in 3 dimensions, using elevations of 0.

•

Check the box Display Google map to display the Google map in background. This box is
not active if the AutoCAD mode is used.

6.

DATA MENU

The options of the Data menu are detailed in chapter 7 of the X3D guide. The options are
mainly used to retrieve data in the tables of the Geotec database. In Site, the default retrieval
(simple query) is done on the Site table or the Axis table.
In Site, the data entry options available in the Data menu (Entry option) and with the buttons of
the application toolbar (
) are those of Site, Axis, Boring, Stratigraphy and
Sample. The user first inserts the sites, followed by the axes and borings related to the sites,
then the stratigraphy of the borings, and finally the samples from the borings. Some fields are
mandatory and are identified by different background and text colors, defined in the preferences
editing window (see paragraph 7 of chapter 6 of the X3D guide).
The Color Selection option is used for the cartographic maps in OpenGL mode. It is detailed in
the SM2 guide.

7.

WINDOW AND HELP MENUS

None of the options of the Window and Help menus is specific to Site. A detailed description
of each option of these menus is done in chapter 8 of the X3D guide.
2018-10-01
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9

INTERACTIVE EDITING

The Site module allows the interactive editing of geotechnical entities, provided that the option
Detect geotechnical entities in the Preferences editing window is checked (see paragraph
7.1.4 of the X3D guide). The interactive menu differs depending on the 2D or 3D mode and on
where the cursor is located.
With any interactive menu, it is possible to launch the modules of Geotec to show the types of
data that can be displayed for the current boring or axis with the Site, Pro, Log and Lab
modules.

8.1.

Interactive editing in 3D view

In the 3D view, if the user right clicks, the contextual menu shown in figure 5 is displayed. The
first and third items are active only when the mouse is over a property column.
The first item is used to create a new record in the table whose data are displayed in the
column. The depth clicked will be displayed by default for the new record. For a sample, it will
be its top depth. For a stratum, it will be its bottom depth, unless the user clicks in a stratum
that is already defined, in which case it will be the depth of a text type record. For the other
tables, it will be the top depth or average depth of the record.
When the cursor is on a record of a property column, the Information option of the interactive
menu opens the appropriate entry form on the data of the current record where the user
clicked. Double-clicking on data has the same role.

Figure 5 - Interactive menu in 3D view

8.2.

Interactive editing in 2D view

In the 2D view, if the user right clicks anywhere other than over a boring or an axis, the
contextual menu shown in figure 6 is displayed.

Figure 6 - Interactive menu in 2D view
Interactive editing
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When the Properties option of the interactive menu is available, it opens the appropriate entry
form on the axis, boring or limit clicked. Double-clicking on the data has the same role.
8.2.1.

Creating a site

By selecting Create Site, the cursor takes this format: . If the user wants to cancel right
away, right click and select Cancel. To create the site, left click at one corner of the new site,
hold down and move the cursor to the diagonally opposite corner; a dotted line shows the area
created. When the button of the mouse is released, the site entry form is displayed; the X and Y
coordinates of the bottom left corner as well as the width and height of the area are
automatically entered.
The user must then enter the site number and any other information in the entry form, and save
the new site by pressing [F10] or the
entry form without saving the record.
8.2.2.

button in the entry form. To cancel, simply close the

Creating and modifying an axis

By selecting Create Axis, the cursor takes this format: . Left click at each point of the axis. A
dotted line shows the movement of the cursor. When the last point of the axis is defined, right
click to display the pop-up menu and select Cancel to erase the axis being created, or
Terminate to edit and save the new axis in the axis entry form that is then displayed and
showing the coordinates of each point clicked.
The user can then enter the axis number and any relevant information in the entry form, before
saving by pressing [F10] or the
button in the entry form. To cancel the axis creation, close
the entry form without saving the record.
Any planned axis (state of axis: P) can be modified with the mouse. When the cursor is on an
axis, it takes this format: . By right clicking, the menu shown in figure 7 is displayed.

Figure 7 - Interactive editing of an axis
When adding an axis point, the cursor becomes . The point will be added between the two
closest points to the cursor. A message is displayed, showing the exact coordinates of the
point. To stop the addition of points, right click and select Terminate.
When the cursor is over an axis point and there are more than two points in the axis, the option
Delete an Axis Point is active. A message is displayed to confirm the deletion of the point.
When the cursor is on an axis point, it takes this format: .By clicking on the point, it takes the
format . Move the point to the desired position, and release the button of the mouse; a
message is displayed to confirm the move.
2018-10-01
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Creating and modifying borings

By selecting Create Borings, the cursor takes this format: . Left click at the location of the
first boring. A dotted line shows the movement of the cursor. Left click as many times as
desired to add borings. When the last boring is defined, right click to display the pop-up menu
and select Cancel to erase all borings being created, or Terminate to edit and save the new
borings. The window shown in figure 8 is then displayed.
The boring editing window shows:
•

The region number, associated to the site selected.

•

The site number. The user can select another from the list of all sites currently displayed.

•

The boring type. The user can select another from the list of types of borings that have a
defined maximum depth.

•

The year of the projected borings, as “yy”. This is added to the boring numbers.

•

The number of borings clicked.

•

The number for the beginning of the sequence. By default, the number is one greater
than the largest boring number found in the site selected.

•

The first boring number. The number is a concatenation of the type - sequence - year.

•

The maximum depth of all planned borings.

•

The axis number to which the borings are attached.

When the user clicks OK, the borings are added in the plan view using the marker for the
corresponding type of planned borings, and their coordinates are also entered in their record.

Figure 8 - Edition of new borings
When the cursor is over a planned boring (state of boring: P), it takes this format: . By
clicking on the boring, it takes the format . Move the boring to the desired position, and
release the button of the mouse; a message is displayed to confirm the move.
Interactive editing
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By right clicking on a planned boring, the option Delete Boring is active. A message is
displayed to confirm the deletion of the boring.
8.2.4.

Selecting borings

By clicking Select Borings, the cursor takes this format: . Click and drag a rectangle
containing the desired borings. The borings selected are then displayed in red. The user may
also select or unselect borings by pressing the [Ctrl] key and clicking on the desired borings.
When all desired borings are selected, right click to display the menu shown in figure 9. The
option Create Group of Borings will open the selection entry form; each boring selected is
identified with its site and boring number. A selection number corresponding to the current
boring number is displayed by default, and can be modified.
The user then enters any other information in the entry form, and saves the new group of
borings by pressing [F10] or the
button in the entry form. To cancel, close the entry form
without saving the record.
With the option Delete Borings, all borings selected and whose state is Planned will be
deleted, after confirming the message displayed. Records for borings of another state cannot
be deleted this way.
Cancel will cancel the boring selection.

Figure 9 - Interactive editing of selection of borings
8.2.5.

Creating and modifying a rectangular limit

By selecting Create Rectangular Limit, the cursor takes this format: . If the user wants to
cancel right away, right click and select Cancel. Left click at one corner of the rectangular limit,
hold down and move the cursor to the diagonally opposite corner; a dotted line shows the area
created. When the button of the mouse is released, the limit entry form is displayed; the X and
Y coordinates of the four corners of the limit are automatically entered. The current site number
is displayed as reference site.
The user then enters the limit number and any other information, and saves the new
rectangular limit by pressing [F10] or the
the entry form without saving the record.
8.2.6.

button in the entry form. To cancel, simply close

Creating and modifying a polygonal limit

By selecting Create Polygonal Limit, the cursor takes this format: . If the user wants to
cancel right away, right click and select Cancel. Left click at each point of the polygonal limit. A
dotted line shows the movement of the cursor. When the last point of the polygonal limit is
defined, right click to display the pop-up menu and select Terminate. The limit entry form is
2018-10-01
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then displayed; the X and Y coordinates of all points of the limit are automatically entered. The
current site number is displayed as reference site.
The user then enters the limit number and any other information, and saves the new polygonal
limit by pressing [F10] or the
without saving the record.

button in the entry form. To cancel, simply close the entry form

Any rectangular or polygonal limit can be modified with the mouse. When the cursor is on a
limit, it takes this format:

. By right clicking, the menu shown in figure 10 is displayed.

Figure 10 - Interactive editing of a limit
When adding a point to the limit, the cursor becomes . The point will be added between the
two closest points to the cursor. A message is displayed, showing the exact coordinates of the
point. To stop the addition of points, right click and select Terminate.
When the cursor is over a point of the limit, the option Delete Point from Limit is active. A
message is displayed to confirm the deletion of the point.
When the cursor is on a point of the limit, it takes this format: . By clicking on the point, it
takes the format
. Move the point to the desired position, and release the button of the
mouse; a message is displayed to confirm the move.

9.

ORGANIZATION OF THE PLAN VIEW

Site produces one type of primary graph: a plan view (PLAN_VIEW). This graph can also be
put in 3 dimensions. We will refer to the plan view and the 3D view, but both correspond to the
same PLAN_VIEW graph. Use the View menu to set the graph in 2D or 3D.
The sub-graphs are only displayed in the 3D view:
•

One of these sub-graphs, HEADER, displays the symbols and names of the borings.

•

The other sub-graphs show properties measured along the borings; for example, the
stratigraphy, results of laboratory tests, results of in-situ tests such as the absorption etc.
These sub-graphs are considered property graphs; they are displayed as columns drawn
parallel to the axis of the borings. The number and type of the property graphs are decided
by the user; some of these graphs have predefined displays.
Each boring displayed in the 3D view will show the defined sub-graphs.

The primary graph and the sub-graphs are defined in the style file by their number, name and
graphic characteristics.
The association between the data and sub-graphs is done:
Organization of the plan view
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By a correspondence between the names of the sub-graphs defined in the style file and the
names of the tables from the database, and by a correspondence, for each sub-graph,
between the names of the curves of the sub-graph and the names of the fields of the table.
The sub-graphs are defined in the graph editing window opened by selecting the Graphs
option of the Tools menu or by clicking the button shown here. Paragraph 4 of chapter 6
of the X3D guide provides more details.
The curves of a sub-graph are defined in the legend and curves editing window opened by
selecting the Legend option of the Tools menu or by clicking the button shown here.
Paragraph 5 of chapter 6 of the X3D guide provides more details.

•

By inserting, in an object anchored to the page or to the primary graph (PLAN_VIEW), a
keyword referring to a value from a table of the database, to a predefined value such as a
logo, or to a value provided by the system like the date or by the application like the page
number. Objects cannot be anchored to the sub-graphs.
The addition of data from the database to “text” and “text zone” objects is described in
details in paragraphs 8 and 9 of chapter 4 of the X3D guide. The association is done with
a keyword like &&table.field to display the field value, or by a keyword like @@table.field
to display an expression equivalent to the field value.

In a style file:
•

There can be as many sub-graphs as desired and sub-graphs can be superimposed;

•

The column graphs display properties taken along the borings. These graphs, as well as
the HEADER graph, must be defined as sub-graphs with a negative #P value;

•

The curves representing fields from the table displayed by the graph must be defined in the
curve editing window, except if the graph has predefined curves (see paragraph 10).

10.

GRAPHS WITH PREDEFINED DISPLAY

Site associates to certain graphs a display that is completely or partially predefined. These
graphs are described in the table.
The predefined curves have numbers greater or equal to 100. Site manages the display of
these curves, but the user can still modify some of the drawing attributes of the curves.
Paragraph 5.2.3 of chapter 6 of the X3D guide explains how to modify the display attributes of a
curve.

2018-10-01
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Graph
PLAN_VIEW

HEADER

STRATIGRAPHY

SAMPLE

BORING

PIEZOMETER
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Characteristics
The PLAN_VIEW primary graph shows the borings and axes in a plan
view. It has ten (10) curves automatically generated:
• The Axis_Points curve shows the turning points of the axes
• The Axis_Curve curve shows the curve of the axes, their
identification and their symbol
• The Axis_Profile curve shows the position of the geophones and the
profiles obtained
• The Boring curve shows the numbers and symbols of the borings
and their projection
• The Limit curve shows the rectangular or polygonal limits
• The Dom_site_db curve delimits the domain of the site as defined in
the database
• The Dom_region_db curve delimits the domain of the region as
defined in the database
• The Dom_site_map curve delimits the site map in the .sit file
• The Dom_region_map curve delimits the region map in the .sit file
• The Dom_calculated curve delimits the domain calculated according
to the option selected in the options window
Curves showing fields from the BORING table can be added to display
information textually under each boring point
The HEADER sub-graph, with its Boring curve, shows the symbols of
the borings and their numbers.
The BORING table provides information about the borings retrieved,
including their number, their type (which influences the display of their
marker or box) and their position.
Typically, the STRATIGRAPHY sub-graph shows the symbols of the
stratigraphic horizons (CODE1 field) or the color of their material
(MATERIAL field).
The STRATIGRAPHY sub-graph has predefined curves if the field
displayed is CODE1, DEPTH_TOP or DESCRIPTION.
Often, a SAMPLE sub-graph is defined to show the RQD of the cores.
Special displays exist for the numbers and the state symbols of the
samples.
The BORING sub-graph is mainly used to display the water levels,
defined by WATER_DEPTH and STABLE_WATER_DEPTH and their
respective dates.
The PIEZOMETER sub-graph shows the installations of the piezometers,
of the observation and supply wells and the measurements of the last
piezometric levels.
This sub-graph displays the contents of the PIEZOMETER,
PIEZOMETER_SEAL and PIEZOMETRIC_LEVEL tables. It only
contains predefined curves.

Graphs with predefined display
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Graph
LIMITS

Characteristics
The LIMITS sub-graph shows the measurements of the Atterberg limits.
A predefined curve displays the plastic and liquid limits using their typical
representation (vertical dashes joined by a horizontal line) and the water
content represented by a circle.
CONSOLIDATION The CONSOLIDATION sub-graph shows the results of consolidation
tests. A predefined curve displays the minimum and maximum
preconsolidation stresses using their typical representation (vertical
dashes joined by a horizontal line) and the probable preconsolidation
stress represented by a down arrow.
A special display exists to represent jointly the type, angle and azimuth of
ROCK_JOINT
the joints, or to represent the angle of the joints.
CPTU_ZONE
The CPTU_ZONE sub-graph shows the ranges of SBT zones if the #1
curve is SBT. 9 predefined curves in the Page allow the user to define
the colors of the 9 different ranges.

11.

THE PRIMARY GRAPH

Site only has one primary graph: PLAN_VIEW. It is described below. If the graph is set in 3D, it
acts as a 3D graph. It is described in paragraph 11.2.

11.1. The PLAN_VIEW graph
The PLAN_VIEW graph shows the plan view of the selected site, region or domain. It should
always be numbered #1. The plan view displays:
•

the symbols of the borings with their identification as well as their projection, if applicable.
The borings are displayed on the plan view if their coordinates are defined or if they are
associated to an axis retrieved and have a chainage and an offset.

•

information from the BORING table as texts, displayed under each boring point

•

the axes retrieved with their identification next to their end points; an axe must have at least
2 turning points.

•

a topographic background, if requested by the user. See paragraph 5.3.1.

11.1.1. Predefined curves
Figure 11 shows the predefined curves (#100 to #134) of the PLAN_VIEW graph. The display
of these curves is not affected by their type.
•

For each axis, the Axis_Points curve shows:
o markers at the turning points of the axis; these markers are different from the end points
of the axis;
o a line passing through the turning points of the axis; this line merges with the outline of
the axis except in the curved sections of the axis;
o the attributes that can be modified for the Axis_Points curve are the line and the
marker.

•

For each axis, the Axis_Curve curve shows:
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o its outline; this line follows the eventual curves defined by a radius at turning points;
o its identification; the name and symbol of the axis are displayed at both ends of the axis;
the orientation of the text shows the origin of the axis: in reading position, the origin is
left;
the marker used for each axis is the one in the current markers file whose name is the
concatenation of the type and state of the axis, for example, LS_R for a realised seismic
line. If no corresponding marker is found, the one defined for the Axis_Curve curve will
be used. The color and dimension of the markers can always be modified.
o the attributes that can be modified for the Axis_Curve curve are the line, the text and
the marker (color and dimension, the symbol has no effect if there exists a marker for
the type and state of the axis in the markers file).
•

For each axis, the Axis_Profile curve shows:
o the location of the geophones; their location is shown by a marker;
o the profile obtained; the thickness and color of the line can be modified by the user;
o the attributes that can be modified for the Axis_Profile curve are the line and marker.

Figure 11 - Predefined curves of the PLAN_VIEW graph
•

For each boring, the Boring curve shows:

The primary graph
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o its identification;
o its symbol; the marker used for each boring is the one in the current markers file whose
name is the concatenation of the type and state of the boring, for example, TP_R for a
realized test pit. If no corresponding marker is found, the one defined for the Boring
curve will be used. The color and dimension of the markers can always be modified.
o the projection of the boring on the axis, if the boring is inclined (with an azimuth and a
dip);
this projection is a line starting at the center of the boring’s symbol, oriented according
to its azimuth, and whose length is the projection value of the boring onto the axis; a
marker, as a dash, is displayed at the end of the projection line. If the user does not
want to see the marker for the projection, he will set the period of the Boring curve to
anything other than 1.
o the attributes that can be modified for the Boring curve are the line (for the projection
and its dash), the text and the marker for the boring (color and dimension, the symbol
has no effect if there exists a marker for the type and state of the boring in the markers
file).
•

The Limit curve shows the rectangular or polygonal limits. The attributes that can be
modified for the Limit curve are the line and the marker (for each corner of the limit).

•

The Dom_site_db curve delimits the domain of the site as defined in the database. The
attributes that can be modified for the Dom_site_db curve are the line and the marker (for
each corner of the domain).

•

The Dom_region_db curve delimits the domain of the region as defined in the database.
The attributes that can be modified for the Dom_region_db curve are the line and the
marker (for each corner of the domain).

•

The Dom_site_map curve delimits the site map in the .sit file. The attributes that can be
modified for the Dom_site_map curve are the line and the marker (for each corner of the
domain).

•

The Dom_region_map curve delimits the region map in the .sit file. The attributes that can
be modified for the Dom_region_map curve are the line and the marker (for each corner
of the domain).

•

The Dom_calculated curve delimits the domain calculated according to the option selected
in the options window (see paragraph 5.3.1). The attributes that can be modified for the
Dom_calculated curve are the line and the marker (for each corner of the domain).

11.1.2. Curves of information
It is possible to display information textually under each boring present in the plan view, as
illustrated in figure 12.
In the legend and curves editing window, for the PLAN_VIEW graph, the user inserts a curve
whose number # is 200 or more (see figure 11). In the scrolling list associated to the Name cell,
the user chooses the field name of the BORING table to display. Only information from the
BORING table can be displayed.
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In the Series column, the user can select “Elevation” - the elevation will be calculated for the
depth selected, or “@@” - the equivalence to the value in the EQUIVALENCE table or in the
LIST_ENG table will be displayed, if defined.
The user can modify the display format in the Title column as well as the drawing attributes for
each curve. The information is displayed in ascending order of the curve numbers (#).

Figure 12 - Example of textual information added in PLAN_VIEW

11.2. The 3D_VIEW
When the PLAN_VIEW is set in 3D, it shows a tridimensional view. The 3D graph has the same
curves as the PLAN_VIEW graph, except the Boring curve. The domains are displayed at their
smallest elevation. Note that if no elevation is found for the domain, it is displayed at Z = 0.
The 3D_VIEW shows:
•

the borings according to their dip and their sub-graphs of properties as columns parallel to
the boring; the display of the properties of the borings is managed by the sub-graphs.

•

the identifiers of the borings with their number and/or a marker characteristic of the type
and state of the boring, or their number in a box.
if the markers are used, each boring will have as marker the one in the markers file whose
name is the concatenation of the type and state of the boring, for example TP_R for a
realized test pit. If no corresponding marker is found, the one defined for the Boring curve
of the HEADER sub-graph will be used (see paragraph 12.4).
for boxes to be used, their dimensions in millimeters must be defined by the user for the
HEADER sub-graph (see paragraph 12.4); the test pits and trenches have rectangular or
square boxes; the other borings have elliptical or circular boxes.

•

the projections on a horizontal plan of the axes retrieved with their identification next to their
ends; an axis must have at least 2 turning points.

•

the profiles of the stratigraphic horizons measured using geophysical methods;
the profiles are defined in the AXIS_PROFILE table, each profile being identified by a type
of material defined in the AXIS_STRATA table. The color of each profile is the one
associated to the material of code S defined in the MATERIAL table for the SPEC site. If
the material is not defined in the MATERIAL table with the S code, the color of the
Axis_Profile curve is then used.

•

a 3D topographic background, if requested by the user. See paragraph 5.3.1.

The primary graph
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12.

THE SUB-GRAPHS

The sub-graphs define the identification of the borings (HEADER sub-graph) as well as the
columns of properties of the borings in the tridimensional view.
Figure 1 shows the graph and sub-graph editing window. Contrary to PLAN_VIEW, the position
and dimensions of the sub-graphs are not relative to the page.
The position of the top of each boring is its position in X, Y and Z, in the 3D view.
The display of each boring represented in the 3D view is done according to its apparent dip, i.e.
the tip of the boring’s projection onto the plane perpendicular to the direction of observation of
the 3D block. The angle and the length of the projection of each boring determine the angle and
the length of the columns, therefore of the property graphs.
For the property graphs, the Left, Width and Right fields define the layout of the columns with
respect to the axes of the borings and the width of these columns. A property graph with a
value of 0.00 in the Left cell will lie against the right side of the boring. If a width of 0.00 is
defined for a sub-graph, the column is not displayed. The Bottom, Height and Top fields are
not used.

12.1. Creation of a property graph
A property graph is created in the graph editing window. More details about graph editing are
available in paragraph 4 of chapter 6 of the X3D guide. Figure 1 shows the graph editing
window in Site. To create a property graph:
•

In the graph editing window:
o Click on the Copy button, which creates a complete copy (with axes and curves) of the
sub-graph selected, or substitute a graph by another.
o Enter a negative value in the #P column of the graph.
o In the scrolling list of the Name cell, select the name of the table from the Geotec
database that contains the property to display. Many graphs can have the same name
because they will not have the same number.
o Define the position of the property column with respect to the borings in the Left, Width
and Right cells.
o Define the graph as Visible.
o Click OK.

•

In the legend and curves editing window:
o Select the new property graph in the scrolling list at the top of the window.
o Delete all the curves from the previous graph.
o Click on Insert and choose the name of the field from the table whose data are to be
displayed, in the scrolling list of the Name cell.
o Choose the type of curve and define its drawing attributes by clicking on the button
under Delete.
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o Click OK.
•

Execute a new data query to fill the new graphs.

•

In the axes editing window, configure the limits of the X-axis of the property graph.

12.2. Types of curves in the sub-graphs
There are several display types for the values in the property graphs: Default, Text, Point,
Histo, Step, Polyline, Polygon, Color and Pattern. All types are described in details in
paragraph 12 of the Log guide.

12.3. Format of the numerical values
The user can define the desired format for the display of numerical values in the Format field of
the drawing attributes window for each curve; for example, "9.999" to have 3 decimals.
No format is predefined for texts placed as graphic objects representing numerical values from
the database. The user can define a format right after the value string in the object’s property
window. For example, to display with 1 decimal number the dimensions of the site at the top of
the report, the user will define a graphic object of Text type with the value
“&&SITE.WIDTH"9.9" , &&SITE.HEIGHT"9.9" ”.

12.4. HEADER sub-graph
The HEADER sub-graph is the graph for the identification and positioning of the borings in the
tridimensional view. For each boring, the HEADER sub-graph can show:
•

Its symbol (a marker or an identification box)

•

Its number

The anchor point of the symbol of each boring is its position in X, Y and Z, in the 3D_VIEW.
To define the identifiers in boxes, the user will modify the HEADER sub-graph. The test pits and
trenches have rectangular or square boxes; the other borings, elliptical or circular boxes. The
Left, Width, Right, Bottom, Height and Top fields reflect the position and size of the boxes
that include the identifiers of the borings:
•

the width and the height define the size of the boxes, in millimeters; the two values must
be positive.

•

the right and the left indicate the position, in millimeters, of the right and left sides of the
boxes with respect to the verticals at the implementation points of the borings.

•

the bottom indicates at which distance, in millimeters, the bottom of the boxes will be
located from the anchor points of the borings.

To display a marker instead of the boxes, the height or width of the HEADER sub-graph must
be 0. The bottom indicates at which distance will be located, in millimeters, the center of the
markers from the anchor points of the borings. The other values are not used.

The sub-graphs
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Figure 13 - Predefined curve of the HEADER sub-graph
For each boring, the Boring curve shows:
•

the marker for the boring, if it has a positive size and if the HEADER sub-graph has at least
one dimension at 0.
The marker is characteristic of the type and state of the boring; the marker used for each
boring is the one in the current markers file whose name is the concatenation of the type
and state of the boring, for example TP_R for a realized test pit. If no corresponding
marker is found, the one defined for the Boring curve of the HEADER sub-graph is used.
The markers are centered on the verticals at the implementation points of the borings.
Vertically, the centers of the markers are located at a distance indicated by the bottom
value defined for the HEADER sub-graph, from the anchor points of the borings.

•

the line between the anchor point and the bottom value of HEADER; if the boring number
is in a box, the border of the box will have the same drawing attributes as the line.

•

the boring number, with the text attributes.

•

the button identified Boring opens the drawing attributes window, where the user can
define how the boring numbers, the boxes and / or the markers (color) will be drawn. The
marker defined for this curve will only be used for the borings for which the concatenation
of the type and state does not correspond to any marker in the .mrk file used.

The drawing attributes of the HEADER sub-graph are not used.

12.5. STRATIGRAPHY sub-graphs
The stratigraphy of a boring is read in the STRATIGRAPHY table. Generally, the user displays
the symbols representing the materials of the stratigraphic layers, by defining the CODE1
curve. Figure 14 shows the predefined curves associated to the CODE1 field. The user also
often displays the color of the materials constituting the layers (MATERIAL field).
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The content of the other fields of the STRATIGRAPHY table can also be displayed. The
STRATIGRAPHY sub-graph has predefined curves if the field displayed is CODE1,
DEPTH_TOP or DESCRIPTION.
12.5.1. Layers and sub-layers
The layers and sub-layers are strata, which are records in the STRATIGRAPHY table.
•

the strata can be classified as three types: R (rock classification), S (simplified
classification) or U (unified classification);
o for an R type stratum, only one material can be defined; its code is entered in code 1;
o for an S type stratum, up to six materials can be defined; their codes (one character
each) are entered in code 1;
the relative proportions of the materials are entered in the proportion field; the main
material has a proportion of 1, a material with traces has a proportion of 4; the
proportions must be entered in the same order as the materials in code 1; more than
one material can have the same proportion;
code 2 is used to indicate grain size or plasticity characteristics, it does not have an
impact on the display;
the line can be used to force the display of the top horizon limit using a specific format;
the type of line requested will prevail over the one used for the lines belonging to the
curve; the types of line that can be imposed are:
▪ L0 blank line;
▪ L1 continuous line;
▪ L2 dotted line;
▪ L3 dashed line;
the values of L0 to L3 entered in code3 in the previous versions of Geotec will be used if
there are no values in Line.
o for a U type horizon, two materials can be defined in code 1 from the scrolling list; they
are separated by a dash;

•

each layer is limited by top and bottom depths and can have a text description.

In addition to the strata:
•

descriptions can be added at specific depths along the boring; these records of type T
(text) have a top depth but no bottom depth;
if a record of type T has a negative depth, its description is displayed above the top line of
the column, generally the ground surface;
if there is no record of type T at a negative depth, Site automatically displays, at the top of
the log, the title of the Elevation curve of the STRATIGRAPHY sub-graph associated to
the DESCRIPTION field;

•

a description can be associated to the bottom of the boring; this record of type E has a top
depth but no bottom depth;
if there is no record of type E, Site automatically displays at the bottom of the column the
title of the curve End_of_borehole of the STRATIGRAPHY sub-graph associated to the

The sub-graphs
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DESCRIPTION field;

Figure 14 - Predefined curves of a STRATIGRAPHY sub-graph
A stratum is a layer if its classification type, its code 1 or its proportions (for the S type) is
different than the preceding stratum.
A horizon is a sub-layer if its classification type, its code 1 and its proportions are the same as
those from the preceding stratum.
The Layers and Sub-layers curves affect the stratigraphic layers and sub-layers.
12.5.2. Display of the STRATIGRAPHY sub-graph for the CODE1 field
Depending on the field specified as the non-predefined curve of the STRATIGRAPHY subgraph, the display associated to the curves varies and depends on Site.
The only case described in this guide is the one where the field entered as the non-predefined
curve is CODE1, which is the most common case. The reader can find information in paragraph
16 of the Log guide about the display particularities when the field entered as the nonpredefined curve is DEPTH_TOP, DESCRIPTION, MATERIAL or another field.
If the CODE1 curve is of Default type:
•

The column shows the stratigraphic symbols in graphic format if they are defined in the
current .ptn pattern file, otherwise using a text format (see paragraph 12.5.3 about the
display of stratigraphic symbols).

•

The Elevation curve displays nothing.

2018-10-01

The sub-graphs

Site Data Management - Geotec (Site module)

25

•

The Layers curve displays the upper limit of the layers.

•

The Sub-layers curve displays the upper limit of the sub-layers.

•

The End_of_borehole curve displays the end of boring limit and, if the record of type E
has a code 1 of R, the bedrock symbol (illustrated below) indicating the refusal (or stop) of
the boring on the bedrock, is drawn with the drawing attributes of the curve.

If the CODE1 curve is of Text type, the column displays the stratigraphic symbols using a text
format and the predefined curves are not considered. The attributes of the limits of the layers
and sub-layers and of the textual stratigraphic symbols are those defined for the CODE1 curve.
If the CODE1 curve is of a type other than Default or Text, nothing is displayed in the column.
The types of the predefined curves are irrelevant.
12.5.3. Display of the stratigraphic symbols
To graphically display a stratigraphic symbol, an X3D pattern must be associated to the
material code to be represented in the pattern file (.ptn) used (and the CODE1 curve must be
of Default type). Otherwise, the material will be represented textually.
•

If a record is of type R, its code 1, for example CAL, will be represented graphically if there
is a pattern named R_CAL, according to our example.

•

If a record is of type S, the graphic representations of the materials specified in code 1 will
be superimposed if a pattern exists for each of these codes, whose name begins with S_
followed by the code to be represented and the proportion of the material;
for example, the CMG code with a proportion of 123 will be represented by three
superimposed patterns if the patterns S_C1, S_M2 and S_G3 exist in the .ptn pattern file
being used.

•

If a record is of type U, if a pattern exists for the complete code1, for example ML-MH, and
whose name is U_ML-MH, it will be used for the graphic representation.

The geotec8.ptn file provided with the installation contains patterns for most of the standard
codes used. The user can refer to the X3D library guide for information about how to look up,
edit and create patterns.

12.6. SAMPLE sub-graphs
Often, a SAMPLE sub-graph is defined to show the N or RQD of the samples. The content of
the other fields of the SAMPLE table can also be displayed. The curves SAMPLE_NO, STATE,
USCS and MATERIAL have a special display.
12.6.1. Display of the SAMPLE_NO curve
If the SAMPLE_NO curve is of Text type, only the sample number is displayed.
If the SAMPLE_NO curve is of Default type, it shows the sample numbers concatenated to
their type, for example SS-01; this layout cannot be modified.
The sub-graphs
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The user can modify the attributes of the text and line showing the top and bottom depths of
each sample.
12.6.2. Display of the STATE curve
If the STATE curve is of Text type, the states of the samples are represented by their textual
code.
If the STATE curve is of Default type, a graphic symbol represents the state of the samples
along their entire length.
Four symbols, shown in figure 15, are generally used to represent the state of the samples.

Figure 15 - Symbols representing the state of the samples
To display these symbols, the drawing attributes of the STATE curve must be defined as
follows:
•

The Line is defined with the color, type and size desired; the line attributes apply to all
states; the line is used as the symbol border and for the cross, for a remolded sample;

•

The Pattern must contain an X3D pattern (usually a hatched pattern); this pattern applies
only to Intact samples.

•

The Filling applies to the Lost and Core samples; it must be defined in two steps:
o It must be defined with the desired color;
o It must be "erased" with the "-" button for the filling not to affect the intact samples.

The remolded samples are the only ones with a symbol set by the Site module; only the line
attributes forming the cross can be modified.
The lost percentage of a sample can be graphically represented at the bottom of the sample
with a height proportional to the lost percentage. To do this, indicate a period of 2 for the
STATE curve. The filling attributes will be used. If a sample has a recovery of 0%, it is drawn
as ‘lost’.
12.6.3. Display of the USCS curve
If the USCS curve is of Default type with a period of 1 or less, the column shows the X3D
patterns defined in the current .ptn patterns file, named “U_USCS”, for example, U_GW.
If the USCS curve is of Default type with a period greater than 1, the column shows the colors
associated to the materials of code U defined in the MATERIAL table for the SPEC site.
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If the USCS curve is of Text type, the column shows the USCS classification in text format. The
attributes of the text and of the limits between the samples are defined for the USCS curve.
If the USCS curve is of a type other than Default or Text, nothing is displayed in the column.
12.6.4. Display of the MATERIAL curve
If the MATERIAL curve is of Default type, the column shows the background colors for the
materials constituting the samples (materials of the borrow pits). The colors are the ones
associated to the materials of code S defined in the MATERIAL table for the SPEC site.
If the MATERIAL curve is of Text type, the column shows the codes of the materials in text
format. The attributes of the textual materials and of the limits between the layers are defined
by the MATERIAL curve.
If the MATERIAL curve is of a type other than Default or Text, nothing is displayed in the
column.
12.6.5. Selection of the types of samples to present
Site allows the user to restrict the display of the samples to just one type. To do this, indicate
the type of samples to display in the Series column. In the example in figure 16, "SS" requests
the representation of the split spoons.
Each cell of the Series column has a scrolling list which displays all the types of samples
inserted in the current database.
The user can select a different type for each curve of a SAMPLE sub-graph. Only the values
associated to the selected type will be displayed. If the cell of the Series column is empty or if
it contains "@@", all the samples will be represented for this curve.

Figure 16 - Selection of a sample type in a SAMPLE sub-graph
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12.7. PIEZOMETER sub-graph
The installations of the piezometers, observation and supply wells as well as the seals, lanterns
and piezometric levels are shown in the PIEZOMETER sub-graph.
Site reads the information about the piezometers in the PIEZOMETER table, the information
about the seals and lanterns in the PIEZOMETER_SEAL table and on the piezometric levels in
the PIEZOMETRIC_LEVEL table.
The PIEZOMETER sub-graph can only contain the predefined curves shown in figure 17, which
are of Default type. The type of the curves has no effect on the display. Paragraph 18 of the
Log guide gives a complete description of each predefined curve of PIEZOMETER. Please
refer to it.

Figure 17 - Predefined curves of the PIEZOMETER sub-graph

12.8. LIMITS sub-graph
The LIMITS sub-graph displays the results of the Atterberg limits measurements: the plastic
limit, the liquid limit and the water content. Site reads the data in the LIMITS table.
When a LIMITS sub-graph is created, the predefined curve PL-LL is created, as shown in
figure 18. This curve shows a typical display, i.e. two vertical dashes representing the plastic
and liquid limits and joined by a horizontal line, as well as an empty circle representing the
2018-10-01
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water content. The curve type is Default. The symbols are positioned at the depth
corresponding to the center of the samples.
The user can open the drawing attributes window and modify the marker, which will then be the
symbol for the water content. The line can be modified; it will have an effect on the horizontal
line and the vertical dashes for PL and LL. The text is displayed by default, but can be
modified or removed (“-” button) via the attributes window.
If the user does not want to display any marker, he will enter a size of 0 for the PL-LL curve. If
he only wants the markers for the limits, he will enter a period of 0 in the attributes window for
the curve.

Figure 18 - Predefined curve of the LIMITS sub-graph
It is also possible to add curves for the W, LL and PL fields to impose a specific display; for
example, to connect all the plastic limits, the liquid limits and the water contents, select the
Polyline type for these curves. Each polyline is defined by the line attribute. If the W, LL and
PL curves are of Point type, only the markers will be displayed.

12.9. CONSOLIDATION sub-graph
The CONSOLIDATION sub-graph displays the measurements of consolidation pressures read
in the CONSOLIDATION table.
When a CONSOLIDATION sub-graph is created, the predefined curve PCMIN-PCMAX is
created, as shown in figure 19. This curve shows a typical display, i.e. two vertical dashes
representing the minimum and maximum preconsolidation stresses and joined by a horizontal
line, as well as an empty down arrow representing the probable preconsolidation stress. The
curve type is Default. The symbols are positioned at the depth corresponding to the center of
the samples.
The user can open the drawing attributes window and modify the marker, which will then be the
symbol for the probable PC. The line can be modified; it will have an effect on the horizontal
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line and the vertical dashes for the minimum and maximum preconsolidation stresses. The text
is displayed by default, but can be modified or removed (“-” button) via the attributes window.

Figure 19 - Predefined curve of the CONSOLIDATION sub-graph
If the user does not want to display any marker, he will enter a size of 0 for the PCMIN-PCMAX
curve. If he only wants the markers for the minimum and maximum stresses, he will enter a
period of 0 in the attributes window for the curve.
It is also possible to add curves for the other fields of the table, the same way as for the curves
of the LIMITS sub-graph (see paragraph 12.8).

12.10. ROCK_JOINT sub-graphs
All the fields from the ROCK_JOINT table can be displayed in curves of a ROCK_JOINT subgraph.
The ALPHA (or ANGLE in the previous versions of Geotec), DIP and TYPE curves have a
special display. These three curves cannot be displayed in the same sub-graph.
The curve associated to the ALPHA (or ANGLE) field has a specific display if it is of Default
type. It then displays the joints as lines inclined according to their angle relative to the core axis
and centered on their average depth. The lines have a length of 80% of the column’s width.
The elements that can be edited for the ALPHA (or ANGLE) curve depend on the type of curve
chosen.
The display is similar for the curve associated to the DIP field, except that the line is inclined
relative to the horizontal, in counter-clockwise direction.
The curve associated to the TYPE field (see figure 20) is used to display information relative to
three fields: TYPE and of one of the following pairs depending on the reference taken for the
measurement of the angles: ALPHA and BETA, or DIP and DIRECTION. If a marker named
J_type is defined and an angle is entered in the database for the same depth, the marker
representing the type will be displayed at the location of the value between 0 and 90 on the X
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axis, and will be inclined according to the azimuth value (between 0 and 360). If no azimuth
value is defined, a value of 0 (vertical) will be used. For this display, the TYPE curve must be of
Default type. If the curve is of Text type, only the type values will be displayed textually.

Figure 20 - TYPE curve of the ROCK_JOINT sub-graph

12.11. CPTU sub-graphs
It is possible to display the ranges of SBT zones calculated as histograms or as textual
description for the results of piezocone tests. For this, the curve #1 of the CPTU_ZONE subgraph must be associated to the SBT field.

Figure 21 - Curve of the CPTU_ZONE sub-graph

•

If the Series cell of the SBT curve is empty, the column will display the ranges of SBT
zones as histograms. The period for the curve must be 0 or a filling must be defined for the
curve to show the different colors for the ranges.
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If the Series cell of the SBT curve contains "@@", the column will display the SBT ranges
as descriptions. If the EQUIVALENCE table contains the description of the zones as
equivalences to their value, this description is displayed; otherwise, the numbers of the
zones are displayed.

Nine predefined curves are automatically included in the Page graph when the SBT curve of
CPTU_ZONE is displayed. These curves named "Zone_1" to "Zone_9" are used to define the
colors of the various values of SBT zones. A series of colors commonly used is proposed by
default. However, the user can modify these colors by editing the "Zone_n" curves.

12.12. Display of property values or of concentrations of contaminants
The PROPERTY_VALUE table contains the values of various properties according to depth;
the properties are defined by the user. Also, the CONCENTRATION table contains the
concentrations according to depth of various contaminants defined in the CONTAMINANT
table.
To display the values of the PROPERTY_VALUE table for a specific property in a column, the
user must:
•

associate the PROPERTY_VALUE table to a sub-graph;

•

define at least one curve associated to a field of the table in the curve editing window;
usually, it is usually the CVALUE field.

•

in the Series column of the curve definition, enter the property for which values are to be
represented;

The display in a column of values from the CONCENTRATION table for a contaminant is done
the same way, with the name of the contaminant in the Series cell.

12.13. Display of elevations and information associated to a depth curve
In a sub-graph other than the ones described above, we can define curves associated to a field
starting with DEPTH_ or finishing with _DEPTH. These curves must be of Default type. We
can add information at each depth in the sub-graph by entering the information to be displayed
in the title of the DEPTH_xxx or xxx_DEPTH curve.
The information displayed can be any text. It can contain the value of a field from a Geotec
table; the syntax is then &&table_name.field_name"format" to display the values, or
@@table_name.field_name"format" to display the values or eventual equivalences (see
paragraph 12.14). The format is not required.
For example, the user can create a column to display the initial and stabilized depths of the
water table using a marker and the reading date. For this:
•

the user associates the BORING table to a sub-graph;

•

the user defines two curves. The first curve is associated to the WATER_DEPTH field and
has this expression in the Title cell: &&BORING.WATER_DATE"yyyy-mm-dd". The
second curve is associated to the STABLE_WATER_DEPTH field and has this expression
in the Title cell: &&BORING.STABLE_WATER_DATE"yyyy-mm-dd". A marker for the
water level can be associated to each curve.
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It is also possible to display the elevations corresponding to the depths presented. These
elevations are displayed if the ELEVATION keyword is specified in the title of the curve. These
keywords cannot be included in a string. The dip of the boring is taken in account to determine
the value of the elevations.
If no title is provided for a DEPTH_xxx or xxx_DEPTH curve of Default type, the depth is then
displayed.
If the user wants to display the depths and the elevations, two DEPTH_xxx or xxx_DEPTH
curves of Default type must be created in the sub-graph. One of the titles will remain empty,
while the other will be ELEVATION. By aligning the characters of a curve by the top and the
other by the bottom, both texts will not be superimposed in the graph.

12.14. Display of equivalences to values
It is possible to display equivalent expressions to some values in a curve if the following
conditions are met:
•

The curve does not belong to a sub-graph with predefined curves;

•

The curve does not belong to a sub-graph representing the CONCENTRATION or
PROPERTY_VALUE table.

•

The curve does not represent a DEPTH_xxx or xxx_DEPTH field;

•

Expressions equivalent to one or many values are defined in the EQUIVALENCE table or
in the LIST_ENG table for the field represented by the curve;

•

The @@ expression is entered in the Series column of the curve.

Regardless of whether the field values are numerical or textual, if the equivalent expressions
are textual, they will only be displayed if the curve is of Default or Text type. If the equivalent
expressions are numerical, they can be displayed regardless of the type of curve.
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